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© 2012 Thorlabs

We aim to develop and produce the best solution for your application
in the field of optical measurement technique. To help us to live up to
your expectations and improve our products permanently we need
your ideas and suggestions. Therefore, please let us know about
possible criticism or ideas. We and our international partners are
looking forward to hearing from you.

Thorlabs GmbH

  Warning  

Sections marked by this symbol explain dangers that might result in
personal injury or death. Always read the associated information
carefully, before performing the indicated procedure.

Please read these advices carefully!

This manual also contains "NOTES" and "HINTS" written in this form.

  Attention  

Paragraphs preceeded by this symbol explain hazards that could
damage the instrument and the connected equipment or may cause
loss of data.

  Note  

4
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1   General Information
The  Smart  Line  Camera  is  designed  for  general  laboratory  use.  Integrated  routines  allows
averaging, smoothing,  as well as saving and recalling data sets.

The initial setup is simple to complete. Following installation of  the software, the LC100 line
camera is  ready to use. Simply plug it  into a USB 2.0 port  and run the application software
SPLICCO. The remainder of this manual is devoted to the setup procedure and features of the
line camera. A troubleshooting section and detailed specifications of  the various components
are provided to further assist. The description of the instrument driver commands can be found
in the VXIpnp VISA instrument driver package.

Application software SPLICCO

SPLICCO is an acronym for "SPectrometer and LIne Camera COntrol". This software can be
used  for  acquiring  direct,  transmittance  and  absorbance  measurements  in  conjunction  with
Thorlabs line cameras and spectrometers.

After the installation the software is able to communicate with the line camera. Additionally, two
virtual devices are included: a line camera and a spectrometer, to demonstrate the functionality
of SPLICCO.

1.1   Safety

Attention

All  statements  regarding  safety  of  operation  and  technical  data  in  this  instruction
manual will only apply when the unit is operated correctly as it was designed for.
All modules must only be operated with proper shielded connection cables.
Only with written consent from Thorlabs may changes to single components be carried
out or components not supplied by Thorlabs be used. 
This precision device is only serviceable if  properly packed into the complete original
packaging  including  the  plastic  foam  sleeves.  If  necessary,  ask  for  a  replacement
package.
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1.2   Ordering codes and accessories

Ordering code Short description

LC100 Smart Line Camera,  350 - 1100 nm

1.3   Requirements

Hardware Requirements:

CPU: 1 GHz or higher

RAM: 256 MB

Graphic card with at least 32 MB memory

Hard disc with at least 100 MB free storage space 

free USB2.0 port 

USB cable according the USB 2.0 specification 

Software Requirements:

Windows ® XP (32-bit) SP3, 

Windows ® Vista (32-bit, 64-bit), 

Windows ® 7 (32-bit, 64-bit)

VISA runtime (version 5.1 or higher)
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2   Installation

2.1   Parts List

Inspect the packaging for damage. If the shipping container seems to be damaged, keep it until
you  have  inspected  the  contents  and  you  have  inspected  the  LC100  smart  line  camera
mechanically and electrically.

Please verify that you have received the following items:

1x  LC100  USB 2.0 CCD line camera

1x  Line camera user manual

1x  SM2 to Nikon F-mount Objective adapter

1x  CD-ROM with application software SPLICCO and drivers

1x  USB 2.0 A -B cable 2 meters

1x  Trigger Input Cable

LC100 USB line camera with all user relevant ports and signal LEDs

(1) USB port 

(2) Linear CCD array

(3) Status LEDs
LED "ON" - Green: Lights up, when the device is ready for operation
LED "BUSY"- Orange: Lights up every time the CCD exposure starts

(4) Trigger Input  and GPIO connector

(5) a) SM2 internal thread
b) mounting threads for Thorlabs cage systems 
c) mounting threads for Thorlabs posts
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2.2   Getting started

The line camera must NOT be connected to your PC while the software is being installed.

Once the software has been installed, please connect the USB cable to the USB 2.0 port on
your PC and the USB B mini connector to the line camera . You will be prompted to allow the
automatic installation of the drivers. After completing, run the application program SPLICCO.

2.2.1   USB requirements

To achieve the maximum performance benefit  from your LC100 USB line camera, you must
have a dedicated USB 2.0 port available on your PC (a built-in USB 2.0 port is recommended). 

2.3   Installing Software

2.3.1   The installation menu

Before installing SPLICCO, please make sure that no LC100 USB line camera  is connected.
After you inserted the SPLICCO installation CD an autorun menu will appear, see figure below.
If autorun is disabled on your system you have to browse the installation CD and run 

"[CD-Drive]:\Autorun\Autorun.exe".

Note
Please be aware that SPLICCO software requires the NI VISA runtime engine V5.1 or above
installed on your system. The installer checks for installed VISA software and, if necessary, will
install the NI VISA automatically. You will be notified accordingly:

Administrator privileges are required for installation. Please contact your system administrator,
if you get an appropriate error message.

In  the  following  section  are  shown  in  detail  the  installation  steps  for  an  installation  on  a
Windows 7©  operating system.
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2.3.2   Installing SPLICCO

Select  "SPLICCO  -  Application  software"  from  the  installation  menu  to  start  the  installation
wizard. You will  be  prompted  to  specify  the  installation path. Confirm with "Next"  when you
selected the installation path of your choice.

Please read the end user agreement carefully, choose "I accept the License Agreement(s)" if
you do so and press "Next" in the following two screens:

The  following  window  states  the  next  installation  steps  and  notifies,  which  software  will  be
installed. Click the "Next" button to begin installation or click the "Back" button to change the
installation settings.
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After the installation was successful you will see a window containing information about a log
file (change log) and other notes. Press "Next" to finish installation.

Now the device drivers will be copied into the system folders. This might  take a few moments
and a command prompt  window will pop up, which will start  the driver installation routine of
windows.

Windows Security  system will notify  you about  device driver installation. You may check the
box "Always trust software from "Thorlabs GmbH" prior to click the Install button. A  firmware
and driver package for all supported devices will be installed as SPLICCO software is designed
to control several hardware devices.
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Finally, you will be prompted to restart you computer in order make changes effective:

2.3.3   Driver Installation

Upon first  connect  of  a LC100 smart  line camera Windows recognizes a new hardware and
starts the driver installation.

Using Windows XP©

Windows starts the driver installation. A popup in the left bottom corner appears, displaying the
name of the device. 

The  "Found  New  Hardware  Wizard"  starts  to  install  the  new  device.  Depending  on  the
configuration of your system, you may be asked if you want to connect to "Windows Update to
search for software" shown in the following figure.

Please select "No, not this time" and click "Next" to continue.
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Select "Install the software automatically" and click "Next" to continue.

Finalize the installation by  clicking "Finish". Now the device is  installed and can be used by
SPLICCO.

The green status LED lights up, the device is installed and ready for use with SPLICCO.

Using Windows 7©

Connect your LC100 line camera. Windows recognizes the connected device and automatically
installs the driver:

  

The green status LED lights up, the device is installed and ready for use with SPLICCO.

2.3.4   Start the GUI

To start SPLICCO click on the desktop icon   or select 'Programs' via the START button in
the Windows task bar and navigate to 'All Programs / Thorlabs / SPLICCO / SPLICCO'. 
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3   Operating Instruction LC100 Smart Line Camera

3.1   Connecting a Device

1. To start a measurement with a LC100 Line Camera connect it  to a USB port of  your PC
with the supplied cable.

2. The SPLICCO connects automatically to all detected devices. 
3. A device can be connected manually: Select 'Connect...'  from the Devices menu or click to

the Connect icon  from the tool bar. 

       

The following window  appears  and  shows all  connected  devices  and  additionally  two  virtual
devices. Now you can select  a device to be used. A  panel will be created according to your
selection  by  default.  If  the  "Create  a  device  window  automatically"  option  is  not  checked,
please use the according panel icon from the main interface.

Press "Cancel" to leave this dialog and "Rescan" to scan the system again for new devices.

Every device can only be opened once. Devices already opened by SPLICCO are marked with
the "running" status and are grayed out in the device selection dialog. Devices used by another
application than SPLICCO are marked with the "locked" status.
Press  "Open  Window"  to  switch  to  the  "Open  Window"  dialog  to  connect  a  window  to  an
already running device.

Furthermore,  you  can  start  a  virtual  line  camera,  which  can  simulate  a  scan.  Through  this
feature you can familiarize yourself with  SPLICCO, without the need of a light source or signal.
You can select to display or hide those virtual devices by checking or unchecking the "Show
virtual devices" box.

For a detailed description about the virtual devices refer to section Virtual devices .

3.2   LC100 Software update

The SPLICCO software comes with a driver update function. The LC100 has a software for the
internal  FPGA  and  one  the  for  the  USB  interface,  their  versions  are  being  checked  upon
Connecting  a  device  by  SPLICCO  software.  In  case  that  the  installed  SPLICCO  version
requires a firmware update, the following warning appears:

58
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Click "Yes" to update. Several message windows appear:

    

After successful installation, the above Connect Device window appears.

If  you  decline  the  LC-100  update,  the  camera  might  not  work  properly  with  the  current
SPLICCO version.

Note

The content of the LC100's internal memory (EEPROM), i.e., the device label  and a saved I/
O Setup configuration , are not being overwritten.

3.3   Integration time

The integration time represents how long the CCD interacts with incoming light. CCD pixels act
like light buckets, gathering photons. The integration time displays the duration for which the
bucket is open. For very bright sources, low integration times are required, whereas for weak
sources, longer integration times should be used. As in the light  bucket analogy, CCD pixels
can  be  overfilled  ("blooming").  This  is  called  saturation  and  will  cause  the  output  to  be
misleading.

Note

If  no  intensities  are  displayed,  please  enter  the  shortest  integration  time  and  increase  it
continuously  until  an  intensity  curve  is  displayed.  As  mentioned  above,  CCDs  are  very
sensitive, and if over-exposure occurs, no intensity can be displayed.

Also,  please  make  sure  the  background  correction  is  disabled  (see  section  Background
Correction  )

36

53

38
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 Integration  time  can  be  set  via  the
control  on  the  lower  left  corner  of  the
device window. The supported range is
defined by the line camera and ranges
from 1.054 ms to 50 s. The integration
time  input  window  uses  milli  seconds,
therefore  the  values  of  1.054  ms  -
50000 ms have to be used to cover the
range. A  window, which only  shows  a
loaded  from  a  file  spectrum  does  not
offer  those  controls  in  the  left  bottom
corner.

For integration time values below 1000
ms,  in  the  lower  right  corner  is
displayed the actual frame rate ("fps" =
frames  per second). When exceed  1s

integration time, the according parameter is changing to "sec per frame".

A change of the integration time affects all windows connected to this device, which are then
updated to show the same integration time.

The  status  LED  "BUSY"  (orange)  lights  up  every  time  the  CCD  exposure  starts.  At  short
exposure time values this appears to the human eye as "continuous ON".

Higher integration times results in higher peaks in the measurement data.
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3.4   Program navigation

SPLICCO can be operated by using the menu or the toolbar.

Menu 

File menu

The 'File' menu contains all functions for saving, loading and exporting measurement data. 

You can save the current  measurement  data as a *.jdx  or *.csv file. This kind of  file can be
loaded into the application. You can also save and load reference data directly.

Devices menu

In the 'Devices' menu you find all functions regarding your actual connected devices. You can
connect / disconnect devices as well as set  the properties of the devices.

View menu

The 'View' menu contains all functions to configure the display windows. All active windows are
listed here. Windows can be opened/closed/zoomed or you can switch between the released
and tabbed view.

Tools menu

All  functions  to  calculate  with  reference  curves  like  transmittance  can  be  found  here.
Furthermore there are tools like taking snapshots from the actual window or copying the current
measurement data to the clipboard. 

Help menu

You will find the online help in this menu. Furthermore, there is a link to the Thorlabs web page
to  check  for  the  latest  drivers  or  software  version.  You  can  check  the  current  version  by
selecting 'About...'.

Tool Bar

The toolbar offers quick access to important functions.

Opens an existing file (*.jdx)

Saves the current measurement in a file (*.jdx)

Prints the current window with user's comment and timestamp

Connect a device

Disconnect a device

Creates and connects a new window to a device

Closes the actual window

Switches to released windows view

Switches to tabbed windows view

Zooms in by factor 2

Zooms out by factor 2

Resets the zoom to full scale

Opens the Devices Settings Panel

Switches between logarithmic and normal y scale

Opens a dialog to configure persistence

Opens a dialog to configure Gaussian transformation
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Opens a dialog to configure colors

Stores the actual measurement plot as reference plot

Loads a reference plot out of a JCAMP-DX file

Deletes the actual windows reference curve

Switches to scope view

Switches to division view

Switches to absorbance view

Switches to transmittance view

Opens the peak finder dialog for the actual window

Copies actual measurement data values to clipboard

Makes a snapshot from the actual window

Opens the windows help for SPLICCO
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3.5   Save and Export Data

SPLICCO can save data either in JCAMP-DX or CSV format.

JCAMP-DX:

stores data and comments
visit "http://www.jcamp-dx.org/" for more information

CSV:

comma separated values
later use with third party software like Microsoft Excel™ or Mathlab™
human readable

To save the measurement data to a JCAMP-DX file select 'Save As ...' from the File menu or
click the  button  from the  toolbar. A  file  dialog  window  appears  and  you can choose  the
filename and directory. 

Click to "Browse" to define the location of the file to be saved to:

http://www.jcamp-dx.org/
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The  file  extension  of  this  file  is  *.jdx. Additionally  you  can choose  the  range  to  store. Text
entered in the "Comments" field will be stored together with the data.

Export Data

Measurement  data  can  be  exported  to  a  *.csv  file  for  use  with  e.g.  Microsoft  Excel™  or
MathLab™. To export the current measurement data to a *.csv file select 'Export CSV...' from
the  File  menu.  A  popup  panel  appears  to  choose  the  target  directory,  filename  and  the
characters for "Separator" and "Decimal Point". 

Reference data can be handled in the same way.
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3.6   Load and Import Data

Previously captured and saved measurement scans can be reopened with SPLICCO without
connecting a device. This can be done from the File menu by selecting "Open..." (  icon) or
"Import CSV..." .

   

Opening a file

SPLICCO can load most JCAMP-DX  files with file extension *.jdx either as a reference  to
use with the live measurement data or in an individual window to show formerly saved data.

To open a *.jdx file, choose "Open" or click to the  icon. Choose the appropriate file using the
Browse button, the selected file is shown in the preview window. Eventually saved comments
are shown in the "Comments" field. 

X and Y Factors represent the resolution. The resolution of the X axis is 1 pixel, the resolution
of  Y axis results from the resolution when the file was saved. By pressing Load the curve is
opened in a new window.

Note

The Load function is used also for loading a reference scan to the current live window. Details
are explained in section References .

18 41

41
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Import data

To import measurement data from a *.csv file select 'File -> Import CSV...' from the menu. 

Please specify the character separating the x & y columns and choose which character marks
the decimal position in the appearing window. Then click to Browse to select the required file:

Click OK to confirm:

Clicking to Load imports the data to a new window.

Note

The Y axis will be displayed only  for values between the min and the max intensity; scaling
factor as for *.jdx is not available.
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3.7   Save and Load Device Settings

SPLICCO  allows  to  save  device  settings  to  and  load  them  from  a  configuration  file  in  xml
format.

The advantage is that you can exactly reproduce your measurement conditions say, next day
or even in a different lab. The only condition is that the type of device (e.g. LC100) must match.

The following parameters are saved:

Device type and Device Label
Serial number
Trigger mode
Integration time
Smoothing mode and settings
Averaging mode  and settings
Persistence and settings
Gaussian transformation and settings
Flip / Revert Picture
Scaling  Y axis (intensity) and X axis (pixel # or wavelength)
Progress indicator  on/off

Additionally, an individual comment can be entered. 

36
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40
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Sample of a configuration file:

The background correction is NOT being saved!

Also,  settings  of  the  graphic  user  interface,  like  color  settings,  released  or  tabbed  view  of
multiple windows, cannot be saved to the device configuration file.
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3.7.1   Save Settings

Open from the File menu the topic "Save Device Configuration":

Select a file name and destination for the configuration file.

and click "Save".
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3.7.2   Load Settings

Open from the File menu the topic "Load configuration":
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Select a file name of the configuration file

and  click  "Load".  A  preview  pane  comes  up  showing  the  settings  saved  to  the  selected
configuration file: 

Click "Load" to apply these settings. 

In case the instrument's serial numbers do not match, you will be noticed about that:

Click Ok to  get  back to  the  preview  pane. You  may  choose  then another  configuration  file
("Browse") or even load the mismatching file.
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3.8   Sequential Recording

SPLICCO  software  allows  a  sequential  recording  of  individual  scans.  The  scan  results  are
saved  in  *.csv  file  format .  Importing  sequential  results  to  an  appropriate  software,  e.g.,
Microsoft  EXCEL©, scans  can be  displayed  in a  3rd  dimension -  time. A  maximum of  1000
scans can be recorded.

The Sequential Recording function can be reached via Tools menu.

There are 2 types of recording modes - Timed Sequential Scan and Fast Sequential Scan.

 

3.8.1   Timed Sequential Scan

Timed Sequential Scan

The Timed Sequential Scan mode is ideally used for long term monitoring. In this mode, a time
interval between the start of  2 subsequent scans can be entered. The interval ranges from 1
sec  to  8760h:59min:59sec.  Alternatively,  the  scan  can  be  triggered  externally,  using  the
hardware trigger input.

Each scan will be saved to a separate file. To the chosen file name (e.g. LC100_sequence.csv)
a time stamp is being appended. The format of the time stamp is

_YYYYMMDD_xxhxxmxxsxxxms

(e.g.,  "_20110506_09h02m15s030ms" stands for May 06, 2011, 09h:02min:15sec:030ms.)

Example:

Select the desired device
Click Browse to open the dialog for selecting a file name

Confirm the entered file name
Define the number of scans to be recorded
Define the time interval between scans - alternatively, choose "External trigger"

18
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Click Go; the progress will be shown in the bar and the remaining time will count down.

After processing the entered number of scans the files will be saved and the window closed

Each result file contains 2 columns - first column is the pixel number, second column states
the intensity measured from the actual pixel. Small negative intensity values (below 0.01) are
caused by CCD noise and/or ADC noise or background correction.

3.8.2   Fast Sequential Recording

Fast Sequential Recording

The Fast Sequential Recording mode allows to record fast changes. The time interval between
two  subsequently  recorded  scans  depends  on  the  integration  time,  if  ≥  10ms.  For  smaller
integration time values it depends on system performance and CCD read-out time. Results are
being saved to a single file.

Example:

Select the desired device
Click Browse to open the dialog for selecting a file name
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Confirm the entered file name
Define the number of scans to be recorded. 
For triggered recording, check the box "External trigger"
Click  Go;  the  recording  starts.  After  finishing,  the  software  needs  to  process  data,  which
takes some time, depending on the number of scans to be recorded.

During  processing  data, in above  window  header may  appear "Sequential  Recording  (Not
responding)", eventually  the  screen may  gray  out  -  this  is  just  a  reaction of  the  operating
system to extended processing time and does not impact the function of SPLICCO software,
so please ignore it.
A sample result file is shown below:

The 1st line of the file contains the time stamps: A1 is the scan start time with accuracy to 1ms,
columns B1, C1, ... contain the start time delay between 1st and actual scan. If the scans were
recorded free running, the delay between subsequent scans is equal to the integration time set
value. The time stamp has a tolerance of ± 1ms.

Further, 1st column (A2, A3,...) states the pixel number and in the same line are recorded the
intensities  measured  from the  actual pixel during the  scans. Small  negative  intensity  values
(below 0.01) are caused by CCD noise and/or ADC noise or background correction.

3.9   Print

SPLICCO allows to print out an actual scan to any printer installed on the operating system.
The appropriate dialog can be opened via the menu File -> 'Print...' or by clicking to the  icon
in the menu bar.

The print-out has a header with information on

device type and device label
date and time
user name
settings for integration time  and averaging counts

36

14 34
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3.10   Device windows

You can open up to 10 measurement  windows for every device. Parameters  like integration
time,  number  of  scans  to  be  averaged  and  trigger  control  take  effect  on  all  of  the  device
windows. All options, which are selected by right click mouse menus, influence only the active
window, with the exception of "Properties" and "Color settings".

There are several views for multiple windows.

Released view - The child windows can be arranged tiled or cascaded:

 

Tabbed view - The child windows are  arranged in tabs:

 

3.11   Zooming and panning

SPLICCO offers several possibilities to zoom/expand areas of interest.

In case the window is in "Zoom mode", you can box-in a region by pressing and holding the left
mouse button. 

By pressing the "Zoom in" ( ) and the "Zoom out" ( ) button in the toolbar you can step in or
step out on the actual windows graph. Use the "Zoom home" ( ) button in the toolbar to zoom
to the original size. You can also zoom home by a right click on the graph and selecting "Zoom
home" in the appearing menu.

The third option to zoom is the use of  the editable graph axis. On each axis you can double
click  the  minimum  or  maximum  value  for  editing.  The  axis  is  rescaled  after  confirming  the
changes.

Another way to zoom is holding the CTRL key on the keyboard and left clicking on the graph to
zoom in and right clicking to zoom out.
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Note

The zoom is limited to 1% of the original size of each axis. Furthermore you cannot zoom out
more than the original size.

Panning

Press and hold the CTRL and SHIFT key on the keyboard to use the mouse to pan the actual
graph. 

Another option is to double click the left or right pixel value and to type-in the range of interest
via  the keyboard. The same can be done for the intensity  axis. This  is  especially  useful for
zooming or panning-in, in only one axis, while keeping the second one static.

3.12   Markers

SPLICCO  provides  two  markers  for  instantaneous  readout  of  pixel
position and amplitude (intensity). 

The  markers  are  being  enabled  by  clicking  to  the  appropriate  button.
Each marker appears as a vertical line named "A" or "B". These lines can
be shifted along the X axis using the mouse (right click and hold). 

Below the buttons the actual X and Y values are displayed: X stands for
wavelength or pixel number, depending on the setting, while Y stands for
the relative intensity at position X.

If both markers were enabled, additionally the distance |A-B| on X axis is
shown.

3.13   Device Settings

The Device settings dialog can be opened in different ways:

Click to  icon in the toolbar
From the Device menu:

By right-clicking to the diagram area and choosing "Properties":



© 2012 Thorlabs32

SPLICCO

3.13.1   Tab Info

The  tab  Info  contains  information  about  manufacturer,  device  name,  serial  number  and
firmware revision:

3.13.2   Tab Common

In  this  tab, trigger and  averaging  modes  can be  set, a  smoothing  can be  enabled  and  the
graphical display can be changed.
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3.13.2.1  Trigger mode

SPLICCO is able to generate internal trigger signals (SW) or use
external trigger signals to take readings at defined time intervals.

You  can  set  the  trigger  mode  in  the  Device  Settings,  tab
'Common'.

The control offers five trigger modes: SW Trigger Continuous, SW
Trigger Single Shot, External Trigger Continuous, External Trigger
Single Shot and the Idle mode. According to the trigger mode the
status symbol and the trigger button in the bottom of  each device
windows  changes. The  trigger buttons  labels  shows  the  possible
option, e.g. "Stop Loop", "Scan 1x", "Arm Trigger" or "---".

Software trigger

SW Trigger Continuous:

The default trigger mode. The software triggers as fast as possible
for maximal data refresh rate. The figure below shows the status
symbol and the trigger button.

By pressing the "Stop Loop" button the data readout is stopped and the symbol changes to:

SW Trigger Single Shot:

In this mode for each click on the trigger button a data set is read out and shown. The status
symbol and the trigger button will appear:

Hardware Trigger

The LC100 line camera is equipped with a hardware trigger input. This input will be enabled by
selecting either the "Ext. Trigger Continuous" mode or the "Ext. Trigger Single Shot" mode.

Ext. Trigger Continuous:

This  mode is  similar to  the "SW  Trigger Continuous" mode, except  that  the  data  readout  is
triggered by an external signal. After each data readout the external trigger will be armed again.
The status symbol and the trigger button will look the same way as in the software continuous
mode.

Ext. Trigger Single Shot:

You have to press the trigger button to arm the external trigger before you can readout data.
While the software is waiting for an external trigger signal the status symbol changes; see the
following two figures below.

Idle:

This  mode  causes  the  device  to  be  idle.  In  this  mode  the  device  does  not  take  any
measurements.
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3.13.2.2  Average Mode

Very  noisy  or  weak  signals  can  be  amplified  by  adding  several
scans, which is known as averaging. SPLICCO provides two kinds
of averaging - Gliding Average and Block Average. The averaging
mode can be set in the Device Settings panel:

Click  to   icon  in  the  toolbar  and  open the  'Common'  tab:  The
number of scans to average can be set in the bottom of the active
panel:

To the right of the number of scans to be averaged a status box is
displayed, indicating the fill level of the buffer used for averaging. 

Gliding Average

This method averages over the most recent number of scans and
is being updated with every new scan. The advantage is that  the
graph is being updated with every scan.

Example:  The  number  of  scans  to  be  averaged  is  set  to  10.  After  starting  acquisition,  the
software calculates the average out of the first two data sets, then out of the first three sets and
so on until the desired number (10) is reached. Then the first data set will be subtracted and
the newest data set will be added to calculation of average. This can be seen also in the buffer
fill level - it grows up to the max and stays there.

Block Average

This method accumulates a number of scans, after that calculates the average, displays it and
starts the averaging process from beginning. The display is updated only after n scans.

Example: The  number of  scans  to  be  averaged  is  set  to  10. The  software  accumulates  10
scans  (can be  seen from the  buffer  fill  level),  calculates  the  average  over  these  10  scans,
displays  the  result  and  restarts  acquisition. (It's  obvious  that  block averaging  decreases  the
frame rate.)

3.13.2.3  Smoothing Method

SPLICCO  provides  the  standard  smoothing  method  called  "Moving  Area  Smoothing",  also
known  as  "Box  Smoothing".  This  kind  of  smoothing  is  comparable  to  a  low  pass  filter,
suppressing  the  high  frequent  noise.  This  is  the  simplest  form  of  smoothing.  The  only
parameter needed is the box width, which indicates how many values are averaged. There is
no weighting of those values.
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Click  to   icon  in  the  toolbar,  open  the  'Common'  tab  and  enable  "Box  Smoothing".  The
smoothing  box  width  can  be  set  below  this  control.  Zero  means  no  smoothing  at  all.  Any
change will instantly affect the actual graph.
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3.13.2.4  Flip and revert picture

SPLICCO  provides  the  possibility  to  mirror   the  actual
measurement  data  displayed  vertically  and/or  horizontally  in  a
window. Click to  icon in the toolbar and open the 'Common' tab:

3.13.2.5  Progress Indicator

In  case  of  long  integration  time,  it  can  be  useful  to  know  the
progress  of  the  actual  scan.  Therefore,  a  progress  bar  can  be
enabled:

To enable this function, just  check the appropriate box. The scan
progress is being indicated for integration time > 500ms. 

3.13.3   Tab LC100 Settings

The  LC100  Settings  tab  allows  to  set  a  custom  device  label,  save  and  clear  background
correction as well as to configure the pattern recognition and the GPIO ports. The two latter
topics are explained in detail in the GPIO Port section .

3.13.3.1  Device Label

SPLICCO allows to assign an individual name to any connected device, called "Device Label".
This device label is an identifier, which eases the operation of  multiple connected devices; it
can be found in the upper left corner of the measurement window:

Click to  icon in the Toolbar and open the 'LC100 Settings' tab. The button "Device label"
opens a dialog box:

43
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Enter a new device label name and press "Save"

Reconnect the device to activate changes: 

The new device label is displayed in the software:
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3.13.3.2  Background Correction

You can subtract  a  background reading to  reduce noise from your ambient  surrounding (for
instance if your room light offsets your base line).

"Save Background Correction" overwrites the currently saved data and remains effective only
during the current SPLICCO session. That means, the background correction will be cleared
automatically, when SPLICCO software is terminated and/or a device is disconnected.

"Clear Background Correction" deletes the correction data immediately. 

The background correction can be easily  saved and turned on/off  from the panel below  the
scan:
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3.14   Peak finder

SPLICCO offers the possibility to find peaks in an actual measurement. The peak finder can be
selected by right clicking on the actual window and selecting "Peak finder..." or from the Tools
menu:

    

or just click the  icon in the toolbar. The following wizard will appear:

In order to specify the relevant peaks, a peak width and a peak threshold can be set. A higher
threshold and a higher peak width will reduce the found peaks.

By pressing the "Calculate" button the peaks specified by those two parameters are calculated
and the list is filled with the found peaks. 

The  found  peaks  can  be  sorted  by  their  location  ("Wavelength/Pixel")  or  by  intensity
("Amplitude") - just click to the desired header - and can be iterated with the help of the arrow
buttons ("<<"  and ">>").

Only  one  peak can be  marked  at  the  same time, but  you can export  the  full  list  into  a  tab
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separated text file with the "Export" button.

3.15   Logarithmic Y Scale

The intensity axis can be scaled linearly or logarithmical. Default display is linear, in order to
switch to logarithmic just click the    icon in the toolbar. Alternatively, the Log Y Scale can be
activated via the View menu or from the dialog after right clicking to the diagram area.

3.16   Color setup

The colors of the graph and its curves can be set by selecting 'Color settings...' from the View
menu or from the right click dialog to the window area or simply by clicking the  icon in the
the  toolbar. The  following  dialog  appears  and  you  can  set  the  colors  to  the  desired  value.
Furthermore you can select to hide the grid or not. If you click on the button 'Reset' the factory
default will be restored. Click on 'Save' to confirm the setting.

3.17   Persistence

SPLICCO offers the possibility to change the persistence attributes for each panel. Activated
persistence leads to  a  fading out  of  previous scans. This  function requires  extra  processing
time and might influence the frame rate. The screenshot below illustrates persistence:

The persistence dialog can be reached either by clicking to the  icon in the menu bar, by
choosing Persistence from the View menu or from the right click to the diagram area dialog. It
offers two sliders for duration and intensity of the persistence feature. After you have chosen
the  parameters,  press  "Apply"  to  make  the  changes  effective.  Press  "Done"  to  leave  the
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dialog. 

3.18   Gaussian Transformation

SPLICCO is able to display the measurement data as the best-fit  Gaussian distribution. The
Gauss Transformation dialog can be reached either by clicking to the  icon in the menu bar,
by  choosing  'Gauss  Transformation...'  from  the  View  menu  or  from  the  right  click  to  the
diagram area dialog.

The appearing dialog offers  two  sliders  for sensitivity  and  significance, which influences  the
Gaussian fit. As persistence, this might decrease the frame rate.

After you have chosen the parameters, press  "Apply"  to  make the  changes  effective. Press
"Done" to leave the dialog. 

3.19   References

An actual scan can be stored as reference. This reference will appear in a different color (see
Color Setup ) and remains unchanged during  the current SPLICCO session unless cleared. 

Click  the  icon in the toolbar, or select 'Store as actual Reference' from either the Tools
menu or from dialog, which appears after a right click on the diagram area.

Delete a reference by selecting 'Clear Reference' or by clicking the  icon.

A scan can be saved as a *.jdx file for later use. 

Save a reference

Store the actual scan as reference. (Note: In order to distinguish the reference scan in the
following screenshot, the integration time was changed after defining the reference. Actually,
the actual scan and the reference are congruent)

40
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Open  the  'Save  As...'  menu,  choose  a  location  and  file  name,  select  'Data  to  store:
Reference' and click Save

Load a reference

Click the   icon in the toolbar, or select 'Load Reference...' from either the Tools menu or
from dialog, which appears after right clicking the diagram area. A dialog box opens:

Browse for the file location, select the desired reference file and click Load. 
The reference curve is copied into the actual window and can be used for future calculations.

 Note 

The  reference  can be  scaled: check the  "Enable  Scaling"  box  -  then the  intensities  can be
scaled and an offset can be entered. 

18
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3.20   Copy to Clipboard

The actual scan data  can be  copied  to  the  clipboard  via  the  menu Tools, choose Copy to
Clipboard, or by clicking to the  icon in the toolbar.

These  data  can  be  pasted  to  a  different  application,  e.g.  Microsoft  EXCEL©  ,  for  further
processing. The data are comma separated pairs of  values, where the first  value represents
the pixel number, the second - the intensity measured at this pixel.

3.21   Snapshot

A Snapshot of the actual scan includes the actual scan diagram area and a header:

device type and device label
date and time
user name
settings for integration time  and averaging counts

To make a snapshot, choose Take a Snapshot from the menu Tools, or by click to the  icon
in the toolbar. A Select File dialog appears, asking for a file name and format. Snapshots can
be saved as *.bmp, *.jpg or *.png files.

3.22   Input / Output Configuration

LC100 Smart  Line Camera provides a number of  auxiliary ports, available through the GPIO
port connector .

Analog Output
TTL Trigger Input 
5 programmable TTL GPIO (General Purpose I/O) ports

The I/O setup dialog can be reached via LC100 Device Settings menu, either via the toolbar
icon   or by right clicking to the diagram area, and then selecting "Properties":

3.22.1   Analog Output

The analog output  delivers  a  DC voltage  of  0 -  4V in  4096 increments, the  max. current  is
16mA. 

Programming

Analog output can be programmed as a static or variable output. In static mode, a constant,
adjustable output voltage can be assigned. 

36
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In the variable mode, the output voltage depends on the intensity of a selected pixel. 

In above dialog box this dependency can be exactly defined: 

select the pixel of interest;
define a maximum and a minimum intensity (in arbitrary units between 0.0000 and 1.0000);
assign to both the min and max intensity an output voltage between 0 and 4 V. The output
voltage  for  the  minimum  intensity  can  be  higher  or  lower   than  that  for  the  maximum
intensity.

3.22.2   Trigger Setup

Trigger Setup allows  to  independently  set  the  timing between internal (software) or external
(hardware) trigger event, exposure control and flash signal. Therefore, 3 sliders are in the tab
Trigger Setup:
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Trigger In Delay

This  delay  adjusts  the  delay  between  the  trigger
(internal  single  shot  or  external)  slope  and  start  of
CCD exposure. Time delay range: 4.5µs...50s.

 Flash Delay

Flash delay  is  the  time  interval  between  the  trigger
(internal or external) slope and flash  control pulse.
Time delay range: 0...50s

Flash Duration

This  slider  allows  to  a  set  the  duration  of  the  flash
control pulse. Flash duration range: 0...50s.

Note

The trigger-in delay can be set even higher than the
sum of  flash delay  and  flash duration. In  this  case,
the exposure of the CCD will be started only after the
flash  lapsed  (extincted).  This  can  be  useful  for
fluorescent applications where a flash or a UV LED is

used for excitation of a probe. The time diagram to the left illustrates the timing.

3.22.3   GPIO

The LC100 smart line camera has 5 programmable I/O ports. These ports are logical ports, i.e.,
the input/output signals are TTL level, active = HIGH:

input voltage: max. 3.3V
logical level "LOW": 0 - 0.4V
logical level "HIGH ": 2.4 - 3.3 V

All five GPIO ports can be linked each to the other by an AND relation.

I/O State

  I/O - inactive, low, off

  I/O - active, high, on

GPIO state - Input

Select the GPIO from the appropriate tab and check the Input box. Now the internal state of
this port (I/O State) will follow the input state.

45
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GPIO state - Output

Select the GPIO from the appropriate tab and check the Output box. 

Output Mode

There are several output modes available from the drop down Mode menu:

fixed: In this mode, to the appropriate GPIO will be assigned a fixed logical HIGH level.
eval: In the evaluation mode, the output state depends on the result condition(s) of the active
evaluation box(es) - see section Pattern Recognition
exposure: In exposure mode, the output is pulsed: pulse duration = 0.5 ms. The rising edge
of the pulse is synchronized with start of  exposure of  the CCD. If  the LC100 is in Software
Trigger Continuous  mode, the pulse is synchronized with starting of a new scan.  
flash: In flash mode, this GPIO port serves as flash control and can be used to release an
external  flash or  switch on  an  external  light  source. This  function  is  based  on  the  trigger
function; the duration of the "flash-active" state and it's delay with respect to a trigger signal
are set in the tab Trigger Setup .

Additional Inputs

As mentioned earlier, the output state of  any GPIO can be linked by an AND gating with the
output  state  of  any  other  GPIO.  This  is  possible  only  in  evaluation  mode.  The  selected
additional logical inputs can be passed through or inverted from the appropriate GPIO output.
If ignore is selected, the GPIO is not linked.

Example:

GPIO 1 is in eval mode and linked with GPIO 2 and GPIO 3; GPIO 2 state is passed through,
GPIO 3 - inverted. Let's see what the linked GPIOs stand for:

48
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GPIO 2 is in exposure mode, it's output is active during exposure. GPIO 3 is in flash mode, so
it's output is active during flash. The logical formula for the GPIO 1 output state is: 

That means, GPIO 1 is active only if the result of the evaluation  is true and in the same time
exposure is going on and in the same time no flash is active.

Output Polarity

Using this feature, the logical polarity of  each GPIO output  can be inverted. This is possible
only if the appropriate GPIO is set to output mode. 

pass through: if the output state is active, the logical signal is HIGH; if inactive - LOW
inverted: if the output state is active, the logical signal is LOW; if inactive - HIGH

In input mode, it's set to pass through and cannot be changed.

Note

When linking another GPIO output as additional input, the pass through /  inverted modes for
the linked inputs are independent  of  the output  polarity  setting of  the appropriate GPIO out.
The following diagram illustrates that for the example above :

48
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3.22.4   Pattern Recognition

LC100 Pattern Recognition is a powerful tool to evaluate a scan for it's curve shape. By other
words, it's  possible  to  observe  the  intensities  detected  within  certain  pixel  ranges, compare
them with given margins and output the result as a logical signal representing "TRUE /  FALSE"
information. 

For this purpose, for each GPIO port the entire  diagram area can be divided into  up to  16
areas of interest ("evaluation boxes").
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LC100 Evaluation boxes - factory default

Each evaluation box is defined by a range of pixel numbers (X1 = start pixel number; X2 = end
pixel number) and a range of  correlated intensities (Y1 = min. intensity; Y2 = max. intensity),
this  way  forming  a  rectangle.  Evaluation  boxes  may  overlap  and  can  be  enabled/disabled
independently.

Note

For each GPIO port, different  numbers, positions  and  sizes  of  the  evaluation boxes  can be
defined.

For evaluation, the intensity values in the appropriate area of interest (AOI) are compared with
the  selected  criterion.  There  are  6  different  criteria  available.  If  the  intensities  match  the
criterion, the  result  of  evaluation  is  TRUE,  else  -  FALSE.  Detailed  explanation  please  find  in
section Area Of Interest .

This evaluation result  is provided via GPIO. In order to use a GPIO for output  of  evaluation
results,  it  must  be  configured  as  an  output  in  evaluation  mode  -  see  section  GPIO  output
modes . TRUE leads to output state HI, FALSE to LO. The GPIO output state can be linked to
one ore more AOI. If the result of more than one AOI is linked to a GPIO, all results must be
TRUE in order to generate a TRUE output signal at the appropriate GPIO (logical AND). 

Note

Different GPIO (in evaluation output mode) can be linked to one ore more common evaluation
boxes  (AOI).  In  such  case,  each  GPIO  evaluates  the  same  evaluation  box(es),  but  the
evaluation criteria can be different  for each individual GPIO. Please see the example   for
detailed explanation.

51
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3.22.4.1  Editing an Evaluation Box

Above figure shows a diagram with 16 defined evaluation boxes. To the right of  the diagram
the evaluation edit box is located.

Select an eval box: Click to a vertical tab, stating the number
and color of the desired eval box. The tabs can be scrolled to
display rested eval boxes. Therefore click to the arrows on the
bottom of the tab bar (see position of the mouse pointer in the
figure to the left)

Enable: If check this, the appropriate GPIO will consider this
evaluation box as activated.

Y2, Y1, X1, X2: here the margins of  the evaluation box can
entered numerically. 

Alternatively,  the  margins  can  be  defined  using  the  mouse
pointer - just  move it  to  a corner of  the evaluation box  in the
diagram (the mouse pointer changes from  to  ), click and
hold left and drag this corner to the desired position. 

The position of  the evalbox can be moved over the diagram
area - place the mouse pointer  inside the evaluation box -
the pointer changes to  - then click and hold left (  ) and
move the eval box to the desired position.

AOI: There are 6 different evaluation criteria available for the AOI (Area Of  Interest). If  the
scan propagation matches the selected criterion, the result of the evaluation in the particular
box is TRUE. Details are explained in section Area of Interest .

Zooming the diagram area

For a better visibility, the diagram area can be zoomed out. Therefore, move the mouse pointer
to a corner of the desired zoom area and press and hold both the Ctrl key and the left mouse

button. The cursor changes from  to . Drag the zoom area to the desired size. The button
"Zoom Home" returns to the view of the entire diagram area. 

51
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Hardware Averaging

LC100 hardware is  able to average the result  of  an evaluation box  prior. This
averaging  can be  extended  to  up to  512  scans. A  progress  bar indicates  the
averaging status:

3.22.4.2  Area Of Interest (AOI)

In order to characterize the path of a scan through the evaluation box, for
each evaluation box ( AOI = Area Of Interest) one out of the 6 available
criteria as below can be selected.

Each  criterion  describes  how  the  intensity  values  in  the  given  pixel
interval (X1, X2) are related to the given intensity interval (Y1, Y2). The
next figure explains these criteria.

Low only: Intensity values of
the  pixels  from X1 to  X2  must
be less than Y1.

Low  +  Center:  Intensity
values  must  be  less  than  Y2
and less than Y1

Center only: Intensity  values
must  be  higher  than  Y1  and
less than Y2

Center  +  High:  Intensity
values must  be higher than Y1
and higher than Y2 

High  only:  Intensity  values
must not be less than Y2

L + C + H: Intensity values within the pixel interval (X1, X2) must be located in all 3 regions,
that means lower than Y1 and between Y1 and Y2 and higher than Y2
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3.22.4.3  Examples

In this section an overview of the possible deciding criteria for the AOI is given.

Scan propagation
through the

evaluation box

Results for AOI criteria

Low Only Low +
Center

Center only Center +
High

High only L + C + H

TRUE FALSE FALSE FALSE FALSE FALSE

FALSE TRUE FALSE FALSE FALSE FALSE

FALSE FALSE TRUE FALSE FALSE FALSE

FALSE FALSE FALSE TRUE FALSE FALSE

FALSE FALSE FALSE FALSE TRUE FALSE

FALSE FALSE FALSE FALSE FALSE TRUE
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3.22.5   Saving and Loading of I/O Configurations

Save  I/O  configuration:  all  settings  of  analog  output ,  trigger  and  of  GPIO  1...5 ,
including the settings of pattern recognition , will be saved. 

Via the LOAD function, previously saved configurations can be re-opened.

Save to File

Click to the Save to File button in either the Pattern Recognition or I/O Setup panel:

  

A dialog box for selecting a file name appears: 

Click to Browse in order to enter a file name: 

The default directory for configuration files is 

- under Windows XP
C:\Documents and Settings\ [username] \Documents\Thorlabs\SPLICCO

- under Windows Vista / 7
C:\Users\ [username] \Documents\Thorlabs\SPLICCO

Enter  a  file  name  and  click  Save  to  save  the  configuration  file.  The  dialog  closes  and  the
previous dialog appears:

43 44 45
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Click to "Save to EEPROM" if the entire I/O configuration needs to be stored to the camera's
internal non-volatile memory. In this case, no file name is required. The saved I/O Setup is then
available by default upon connect of the camera.

If you don't want to save to EEPROM, click "Close"

Note

Current  settings  for  GPIO,  analog  out,  trigger  and  pattern  recognition  (configuration  of
evaluation  boxes)  are  saved  automatically  when  exiting  SPLICCO  software  or  just
disconnecting  the  software  from  the  camera,  as  long  as  the  camera  remains  physically
connected to the USB port of the PC. Once the camera was disconnected physically, upon
re-connect the settings of the I/O ports, analog out, trigger and pattern recognition are loaded
from the camera's internal EEPROM.

When  saving  a  configuration  file,  please  make  sure  not  to  overwrite  an  already  existing
configuration.

Load from File

A previously saved I/O configuration can be re-opened. Click to the Load from File button in
either Pattern Recognition or Input/Output Configuration panel. A dialog box for selecting a file
name appears: 

Click to Browse in order to select a file name:
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The default directory for configuration files is 

- under Windows XP
C:\Documents and Settings\ [username] \Documents\Thorlabs\SPLICCO

- under Windows Vista / 7
C:\Users\ [username] \Documents\Thorlabs\SPLICCO

Select the required directory and file name, then click Load to load the configuration file. The
dialog closes and the previous dialog appears. Click "Close" to finish:

Load from EEPROM

A saved to the LC100 camera I/O configuration can be re-opened. Click to the Load from File
button in either Pattern Recognition or Input/Output Configuration panel, then in the next dialog
"Load from EEPROM":

The configuration will be read out from the camera and displayed in the GUI.

3.22.6   Stand Alone Operation

Owing to the capability of the LC100 Smart Line Camera to save the complete I/O configuration
to the internal, non-volatile memory (EEPROM), it can be operated without SPLICCO.

The saved to EEPROM I/O configuration includes:

1. Analog output  configuration
2. Trigger mode  (and trigger delay , if applicable)
3. Flash  delay and duration (in case, a GPIO was configured as flash output)
4. All GPIO  settings including the according individual evaluation boxes

In this operating mode, the LC100 must be powered via the USB interface, e.g. by connecting it
to  a  USB power  supply  or  a  PC.  The  GPIO  ports  deliver  the  output  signal.  This  way,  the
camera  can  recognize  predefined  patterns,  using  GPIO1...GPIO5,  and/or  the  intensity  of  a
certain pixel can be observed via the analog output.

In stand alone operation, the saved trigger function is active as well.

All output  signals are provided at  the GPIO port  connector  and can be connected via the
included trigger cable (CAB-LC100 ) to peripheral devices. 
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3.23   Application Note

This  section  hopes  to  aid  the  user,  by  giving  tips  or  hints  on  how  to  obtain  the  best
measurements  with  the  Smart  Line  Camera. It  begins  with  a  few  general  suggestions  and
finishes by giving a choice of question with solutions.

For a good signal to noise (S/N) ratio, it is recommended to have the spectral data of interest in
between 70% and 95% of the intensity scale (0.7 - 0.95). This ensures that the signal is above
the background noise, but  not  overexposed. You can identify  an overexposed  signal by  the
increased line width (see: blooming) and a characteristic plateau of the signal maximum.

If your signal looks similar to the sample in the above figure, decrease the integration time to
get a maximum peak intensity in between 0.9 and 1.0. If your signal is still overexposed at the
minimum integration time of 1.054 ms, it is recommended to use neutral density filters or other
optical attenuator in front of the light source to decrease its intensity.

If the signal you are evaluating is very small, you can increase the integration time. As shown in
the next figures, this way the peak intensity raises from ~ 0.018 ( equal to 1.8% of  the max.
intensity) to about 0.7 (70%), which is a recommended value.

Scan, recorded at 7 ms integration time Scan, recorded at 300ms integration time

If you are already at the maximum or if other parameters of your experiment do not permit long
exposures, you can also use the averaging function to raise you signal above the noise. The
result can be seen in the following figures. Please note, that the intensity is around 0.018 which
corresponds to 1.8% of the available intensity scale.
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Scan, recorded at 7 ms integration time and 1 average Scan, recorded at 7ms integration time and 10
averages

Blooming

Blooming  is  a  property  owned  by  all  CCD  sensors,  as  used  in  the  LC100.  Strongly
overexposed  pixels  tend  to  discharge  neighboring  /  adjacent  pixels,  even  if  they  are  not
illuminated. This can be seen in the scan by an increased pattern width, which could lead to
misinterpretations of the signal. You can avoid this effect by decreasing the integration time or
using optical attenuators, as described above.
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4   Virtual Devices

4.1   What are virtual devices?

SPLICCO offers  a  special  feature  named  "Virtual  devices"  which allows  to  demonstrate  the
various application features without having a real device connected to the PC.

Those  virtual  devices  can simulate  line  cameras  or  spectrometers. The  properties  of  virtual
devices can be set and will be stored in a XML file.

Available parameters:

device type
number of pixels
minimum and maximum wavelength
manufacturers and instruments name
serial and revision number
alias
lock status

4.2   Configuration of virtual devices

Virtual  devices  offers  some  options  to  manipulate  the  simulated  data.  The  settings  can  be
changed in Device Settings  dialog, tab 'Virtual settings'.

Virtual spectrometer:

If  the  virtual  device  simulates  a  spectrometer  the  "Data  Generation Mode"  offers  the  mode
"Peaks" only . Each time you select this mode new peaks will be generated. With the help of
the control "Noise" the noise level in % can be changed as well as the fluctuation.

31
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Virtual line camera:

If  the  virtual  device  simulates  a  line  camera, the  "Data  generation mode"  offers  the  modes
"Line"  and  "Curve". The  noise  level  and  the  fluctuation can be  set  and  the  baseline  of  the
measurement and the amplitude of the curve can be changed.

4.3   The virtual devices description file

All virtual devices used by SPLICCO are described by a XML file, which can be modified with a
simple text editor, e.g., Notepad. This description file can be found in the installation folder of
SPLICCO software:

C:\Program Files\Thorlabs\SPLICCO\CameraDescription.xml

HINT:  Make a backup of this file before you modify the original to restore it if needed.

Please  close  SPLICCO  before  you  edit  this  file.  The  changes  will  become  active  after
SPLICCO is started again.

Each virtual device has the following parameters:

DEVICETYPE The device type. 0 for a spectrometer, 1 for a virtual line camera.

NUM_PIXELS The number of pixels. 1 < NUM_PIXELS < 10000

WAVELENGTH_MIN The minimum wavelength, minimal value should be ≥ 0.

WAVELENGTH_MAX The maximum wavelength, maximal value should be ≤10000.

MANUFACTURER The manufacturers name.

INSTRUMENT The instruments name.

SERIALNUMBER The virtual devices serial number.

REVISION The virtual devices revision number.

ALIAS The virtual devices alias.

LOCKSTATUS The  virtual  devices  lock  status.  0  means  unlocked,  1  means
locked. The device can only be opened if the lockstatus is 0.
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To create a new virtual device for SPLICCO, please open the file "CameraDescription.xml" in
the installation folder. A new entry should be formatted in the same way as the original virtual
devices. Open the description file, add your device and save it as XML file to above folder.

Note

Please make sure that serial numbers are unique.

Example:

The following changes were made; a third device was added in lock state:

This leads to the virtual devices dialog as below:



© 2012 Thorlabs

5 Write Your Own Application

61

5   Write Your Own Application
In order to write your own application, you need a specific instrument driver and some tools for
use in different  programming environments. The driver and  tools  are  being installed  to  your
computer during software installation and cannot be found on the installation CD.

In  this  section  the  location  of  drivers  and  files,  required  for  programming  in  different
environments, are given for installation under Windows XP (32 bit) and Windows 7 (32 and 64
bit)

 Note 

SPLICCO software and drivers are 32 bit applications. As for this reason, in  32 bit systems,
they are installed to 

C:\Program Files\...  

while in 64 bit systems - to  

C:\Program Files (x86)\...

In the table below you will find a summary of  what files you need for particular programming
environments.

Programming
environment

Necessary files

C, C++, CVI *.h (header file)

*.lib (static library)

C# .net wrapper dll

Visual Studio *.h (header file)

*.lib (static library)

or 

.net wrapper dll

LabView *.fp (function panel) and NI VISA instrument driver 

Beside  that,  LabVIEW  driver  vi's  are  provided  with  the  *.llb
container file

 Note 

All above environments require also the NI VISA instrument driver dll !

In the next sections the location of above files for all hardware, supported by SPLICCO drivers,
is described in detail.
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5.1   CCS Series

NI VISA Instrument driver:

C:\Program Files\IVI Foundation\VISA\WinNT\Bin\CCS_Series_Drv_32.dll

 Note  

This instrument driver is required for all development environments!

The source code of this driver can be found in

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs CCSseries\CCS_Series_Drv.c

Online Help for NI VISA Instrument driver:

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs CCSseries\Manual

NI LabVIEW driver

C:\Program Files\National Instruments\LabVIEW xxxx\Instr.lib\CCSseries\CCSseries.llb 

(LabVIEW container file with driver vi's -  "LabVIEW xxxx" stands for actual LabVIEW
installation folder.) 

Header file

C:\Program Files\IVI Foundation\VISA\WinNT\include\CCS_Series_Drv.h

Static Library

C:\Program Files\IVI Foundation\VISA\WinNT\lib\msc\CCS_Series_Drv_32.lib

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs CCSseries\CCS_Series_Drv_32.lib

Function Panel

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs CCSseries\CCS_Series_Drv.fp

.net wrapper dll

C:\Program Files\Microsoft.NET\Primary Interop Assemblies\Thorlabs.CCS_Series.dll

Example for C

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs CCSseries\Examples\C

sample.c - C program how to communicate with a CCS series spectrometer

sample.exe - same, but executable

Example for C#

Solution file:

C:\Program Files\IVI Foundation\VISA\WinNT\ThorlabsCCSseries...
...\Examples\CSharp\CCS100_CSharpDemo.sln
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Project file

C:\Program Files\IVI Foundation\VISA\WinNT\ThorlabsCCSseries... 
...\Examples\CSharp\CCS100_CSharpDemo\CCS100_CSharpDemo.csproj

Executable sample demo 

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs CCSseries...
...\Examples\CSharp\CCS100_CSharpDemo\bin\Release\CCS100_CSharpDemo.exe

Example for LabView

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs CCSseries\Examples....

...\LabVIEW\CCS Series Sample.llb

5.2   LC100 Smart Line Camera

NI VISA Instrument driver:

C:\Program Files\IVI Foundation\VISA\WinNT\Bin\LC100_Drv_32.dll

 Note  

This instrument driver is required for all development environments!

The source code of this driver can be found in

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC100\LC100_Drv.c

Online Help for VISA Instrument driver:

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC100\Manual

NI LabVIEW driver

C:\Program Files\National Instruments\LabVIEW xxxx\Instr.lib\LC100\LC100.llb 

(LabVIEW container file with driver vi's -  "LabVIEW xxxx" stands for actual LabVIEW
installation folder.)

Header file

C:\Program Files\IVI Foundation\VISA\WinNT\include\LC100_Drv.h 

Static Library

C:\Program Files\IVI Foundation\VISA\WinNT\lib\msc\LC100_Drv_32.lib 

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC100\LC100_Drv_32.lib

Function Panel

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC100\LC100_Drv.fp

.net wrapper dll

C:\Program Files\Microsoft.NET\Primary Interop Assemblies\Thorlabs.LC100.dll



© 2012 Thorlabs64

SPLICCO

Example for C

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC100\Examples\C

sample.c - C program how to communicate with a LC100 Smart Line Camera

sample.exe - same, but executable

Example for C#

Solution file:

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC100\Examples...

...\CSharp\ LC100_CSharpDemo.sln

Project file

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC100... 

...\Examples\CSharp\LC100_CSharpDemo\LC100_CSharpDemo.csproj

Executable sample demo 

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC100...
...\Examples\CSharp\LC100_CSharpDemo\bin\Release\LC100_CSharpDemo.exe

Example for LabView

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC100\Examples...

...\LabVIEW\LC100 Sample Source Distribution.llb

5.3   SPX Series

NI VISA Instrument driver:

C:\Program Files\IVI Foundation\VISA\WinNT\Bin\SPX_Drv_32.dll

 Note  

This instrument driver is required for all development environments!

The source code of this driver can be found in

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs SPx\SPX_Drv.c

Online Help for VISA Instrument driver:

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs SPx\Manual

NI LabVIEW driver

C:\Program Files\National Instruments\LabVIEW xxxx\Instr.lib\SPx\SPX.llb 

(LabVIEW container file with driver vi's -  "LabVIEW xxxx" stands for actual LabVIEW
installation folder.) 

Header file

C:\Program Files\IVI Foundation\VISA\WinNT\include\SPX_Drv.h
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Static Library

C:\Program Files\IVI Foundation\VISA\WinNT\lib\msc\SPX_Drv.lib

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs SPx\SPX_Drv.lib

Function Panel

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs SPx\SPX_Drv.fp

.net wrapper dll

C:\Program Files\Microsoft.NET\Primary Interop Assemblies\Thorlabs.SPx_Drv.dll

Examples for CVI:

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs SPx\Examples\CVI

contains examples in source code and executable

5.4   LC1 Line Camera

NI VISA Instrument driver:

C:\Program Files\IVI Foundation\VISA\WinNT\Bin\LC1_Drv_32.dll

 Note  

This instrument driver is required for all development environments!

The source code of this driver can be found in

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC1\LC1_Drv.c

Online Help for VISA Instrument driver:

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC1\Manual

NI LabVIEW driver

C:\Program Files\National Instruments\LabVIEW xxxx\Instr.lib\LC1\LC1.llb  

(LabVIEW container file with driver vi's -  "LabVIEW xxxx" stands for actual LabVIEW
installation folder.) 

Header file

C:\Program Files\IVI Foundation\VISA\WinNT\include\LC1_Drv.h

Static Library

C:\Program Files\IVI Foundation\VISA\WinNT\lib\msc\LC1_Drv.lib 

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC1\LC1_Drv.lib

Function Panel

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC1\LC1_Drv.fp
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.net wrapper dll

C:\Program Files\Microsoft.NET\Primary Interop Assemblies\Thorlabs.LC1_DRV.dll

Examples for CVI

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC1\Examples\CVI

contains examples in source code and executable

Examples for LabVIEW

C:\Program Files\IVI Foundation\VISA\WinNT\Thorlabs LC1\Examples...

...\Labview\LC1-USBexample.llb
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6   Maintenance and Service

6.1   Maintenance

Protect the LC100 smart line camera  from adverse weather conditions. The LC100 line
camera is not water resistant.

Attention
To avoid damage to the spectrometer, do not expose it to spray, liquids or solvents!

The unit does not need a regular maintenance by the user.

If necessary the unit and the display can be cleaned with a cloth dampened with water.

The LC100 line camera does not contain any modules that could be repaired by the user
himself. If a malfunction occurs, the whole unit has to be sent back to Thorlabs . Do not
remove any covers!

6.2   Version Information

The menu entry 'Help -> About' displays all application relevant data: Splicco , VISA and the .dll
versions.

In case of  a support  request, please submit  the software version of  the application. This will
help to locate the error.

Visit Thorlabs website www.thorlabs.com for available updates to download.

76
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6.3   Troubleshooting

SPLICCO software terminates with error message "Software cannot be installed"

Check if you have administrator privileges on your computer
For WindowsXP© users: Make sure, Service Pack 3 is installed.

SPLICCO cannot find any devices but the virtual devices : 

Check if VISA runtime 5.1 or higher is installed.
Make sure that the connected device is made by Thorlabs.
Try to connect the device to another USB port.

Installation wizard prompts to specify the path of a ".sys" file:

point wizard to "Windows\System32\drivers"

When connecting a spectrometer, an error message is displayed:

This  error message  can be  ignored. The  reason is  that  firstly, Windows  recognizes  a
device which requires a firmware download into the device. After finishing the download,
the  spectrometer  reboots  and  a  identifies  himself  with  the  exact  type.  Windows  may
recognize this reboot as a disconnect and thus, the above error message appears. Don't
worry - your device will operate normally.

Measurement is running but the diagram is not updated with new measurement values :

Look if the device is set to idle mode.
Maybe you pressed the "Stop" button.
Set  device  into  "software  trigger  single  shot"  mode,  trigger  once,  return  to  "software
trigger continuous" mode
if in "external trigger single/continuous", check your trigger source or re-arm the trigger

After opening an exported *.csv file with Microsoft Excel, a large number of incorrect numbers
are displayed at the Excel sheet :

The decimal separator in your Microsoft Excel may be set to ',' instead to '.'. The *.csv
files generated by this program requires that Excel interprets '.' as the decimal separator.
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"Found New Hardware Wizard" finishes with the error "the wizard cannot find the necessary
software":

This error occurs when the installer cannot find SPLICCO installed on your system.
Install SPLICCO.
Be sure that your device is configured as a VISA device. 
Check if VISA runtime 5.1 or higher is installed on your system.

The Intensity of the measured signal does not increase linearly with the integration time:

The CCD array applies an electronic shutter function, if  integration times below 4ms are
used. In that  case the pixels are sequentially recharged, until the time to the next  CCD
readout matches the wanted integration time. Unfortunately the manufacturer of the CCD
does not guarantee this recharging/resetting of the array to be 100% effective. Therefore
it  cannot  be guaranteed that  all photons are ignored, before the actual integration time
starts.  This  might  cause  peak  heights  to  in-  or  decrease  to  a  higher  degree  than  the
integration time was changed.
If you want to make relative comparisons of signal heights or areas beneath the curve, try
using integration times above 4ms and use the dark current correction (Properties/LC100
settings/ Save dark current correction).

The scan seems to be shifted - the intensity at pixel #0 is displayed at pixel # 512

This is a synchronization issue between the camera and the software. 512 is the size of
the USB buffer. Please change trigger mode or averaging temporarily - this stops the data
acquisition and resets the buffer.
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Error messages as below appear

   and  / or  

Actually, prior to above error messages another panel should have appeared:

Usually, the reason is a hardware disconnect - the USB cable has been unplugged.
Please check.
If a USB hub is used, it's power supply might have dropped.
A common USB interface failure might have occurred.
Possibly, the computer has been turned to Sleep or  Hibernate during a running SPLICCO
session - after wake up, the session won't be restored.
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7   Appendix

7.1   Technical Data

LC100

Sensor Specifications

Detector Range (CCD Chip) 350 - 1100 nm

CCD Pixel Size 14 µm x 56 µm ( 14 µm pitch )

CCD Sensitivity 240 V / ( lx · s )

CCD Dynamic Range 1) 333

CCD Pixel Number 2048

Integration Time 1.054 ms − 50 s

Scan Rate Internal Trigger 2)  Max  900 scans/s

S/N Ratio 3) ≤2000 : 1

External Trigger

Trigger Input BNC

Trigger Signal TTL 5 V and 3.3 V

Trigger Frequency, Scan Rate 
2)  Max 450 Hz, 450 Scans/s

Trigger Pulse Length Min 50 ns

Trigger Delay 4.5 µs

Number of GPIOs 5

GPIO Type 3.3 V TTL

Region of Interests 16

Analog Output Programmable 0 - 4 V

General Specs

Interface Hi-Speed USB2.0 (480 Mbit/s)

Dimensions ( L x W x H ) 80 mm x 80 mm x 33 mm (3.13" x 3.13" x 1.30")

Weight <0.4 kg

Operating Temperature Range 
4)

0 to 40 °C

Storage Temperature Range -40 to 70 °C

All technical data are valid at 23 ± 5°C and 45 ± 15% rel. humidity (non condensing)

1) ratio of saturation voltage to dark current voltage
2) 1.055 ms integration time
3) with 10x averaging, depending on integration time; for single shot use CCD dynamic range
4) non-condensing
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7.1.1   GPIO port connector

Pin # Description

1 Trigger Input, LL TTL (max. 3.3V; 0 - 0.4V = LOW, 2.4 - 3.3 V = HIGH)

2 Common GND (Trigger and GPIO)

3 Analog Output, 0 - 4V DC in 4096 increments, max. current 16mA 

4 -8 GPIO ports 1-5,  LL TTL

CAB-LC100 Trigger cable
DIN 47100 color code

 Pin #  Color  Description

1 BNC plug  Trigger In

2 BNC shield, brown  Trigger Ground

3 green  Analog Out

4 yellow  GPIO1

5 gray  GPIO2

6 pink  GPIO3

7 blue  GPIO4

8 red  GPIO5

white n.c. (unused)
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7.2   Dimensions
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7.3   Certifications and Compliances

Category Standards or description

EC Declaration of Conformity - EMC Meets intent of Directive 2004/108/EC 1) for Electromagnetic
Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European
Communities: 

EN 61326:2006 EMC requirements for Class A electrical equipment for measurement,
control and laboratory use, including Class A Radiated and Conducted
Emissions 2,3,4) and Immunity. 2,3,4)

IEC 61000-4-2 Electrostatic Discharge Immunity (Performance criterion B)

IEC 61000-4-3 Radiated RF Electromagnetic Field Immunity (Performance criterion
A) 

IEC 61000-4-4 Electrical Fast Transient / Burst immunity (Performance criterion B)

FCC EMC Compliance Emissions comply with the Class A Limits of FCC Code of Federal
Regulations 47, Part 15, Subpart B 2,3,4).

EC Declaration of Conformity -  Low
Voltage 

Compliance was demonstrated to the following specification as listed
in the Official Journal of the European Communities:  Low Voltage
Directive 2006/95/EC 5)

EN 61010-1:2001 Safety requirements for electrical equipment for measurement, control
and laboratory use.

UL 61010-1 2nd ed. Safety requirements for electrical equipment for measurement, control
and laboratory use. 

CAN/CSA C22.2 No. 61010-1 2nd

ed. 
Safety requirements for electrical equipment for measurement, control
and laboratory use. 

IEC 61010-1:2001 Safety requirements for electrical equipment for measurement, control
and laboratory use. 

Equipment Type Test and measuring 

Safety Class Class I equipment (as defined in IEC 60950-1:2001) 

1) Replaces 89/336/EEC
2) Compliance demonstrated using high-quality shielded interface cables.
3) Emissions, which exceed the levels required by these standards, may occur when this equipment is connected to
a test object.
4) Minimum Immunity Test requirement.
5) Replaces 73/23/EEC, amended by 93/68/EEC.
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7.4   Listings

7.4.1   List of acronyms

The following acronyms and abbreviations are used in this manual:

CCD Charge-coupled Device 

CSV Comma Separated Values

DLL Dynamic Link Library

FCC Federal Communications Commission

GPIO General Purpose Input/Output

GUI Graphical User Interface

IEC International Electrotechical Commission

LL TTL Low Level TTL

OEM Orginal Equipment Manufacturer

PC Personal Computer

PCB Printed Circuit Board

RoHS Restriction of the use of certain hazardous substances in electrical and electronic
equipment

SPLICCO Spectrometer and Line camera Control

SW Software

USB Universal Serial Bus

VISA Virtual Instrument Software Architecture

VME Virtual-8086 Mode Enhancement

VXI VMEbus eXtensions for Instrumentation

VXIPNP VMEbus eXtensions for Instrumentation Plug aNd Play

WEEE Waste Electrical and Electronic Equipment Directive

XML eXtensible Markup Language 
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7.4.2   Thorlabs Worldwide Contacts

USA, Canada, and South America

Thorlabs, Inc.
56 Sparta Avenue
Newton, NJ 07860
USA
Tel: 973-579-7227
Fax: 973-300-3600
www.thorlabs.com
www.thorlabs.us (West Coast)
Email: sales@thorlabs.com
Support: techsupport@thorlabs.com

Europe
Thorlabs GmbH
Hans-Böckler-Str. 6
85221 Dachau
Germany
Tel:  +49-8131-5956-0
Fax: +49-8131-5956-99
www.thorlabs.de
Email: europe@thorlabs.com

UK and Ireland
Thorlabs Ltd.
1 Saint Thomas Place, Ely
Cambridgeshire CB7 4EX
Great Britain
Tel:  +44-1353-654440
Fax: +44-1353-654444
www.thorlabs.com
Email: sales.uk@thorlabs.com
Support: techsupport.uk@thorlabs.com

France
Thorlabs SAS
109, rue des Côtes
78600 Maisons-Laffitte
France
Tel:  +33-970 444 844
Fax: +33-825 744 800
www.thorlabs.com
Email: sales.fr@thorlabs.com

Scandinavia
Thorlabs Sweden AB
Möndalsvägen 3
412 63 Göteborg
Sweden
Tel:  +46-31-733-30-00
Fax: +46-31-703-40-45
www.thorlabs.com
Email: scandinavia@thorlabs.com

Japan
Thorlabs Japan, Inc.
Higashi Ikebukuro
Q Building 1st Floor 2-23-2
Toshima-ku, Tokyo 170-0013
Japan
Tel:  +81-3-5979-8889
Fax: +81-3-5979-7285
www.thorlabs.jp
Email: sales@thorlabs.jp

China
Thorlabs China
Room A101, No. 100
Lane 2891, South Qilianshan Road
Putuo District
Shanghai
China
Tel:  +86-21-60561122
Fax: +86-21-32513480
www.thorlabs.hk
Email: chinasales@thorlabs.com

mailto:techsupport@thorlabs.com
mailto:europe@thorlabs.com
mailto:techsupport.uk@thorlabs.com
mailto:sales.fr@thorlabs.com
mailto:scandinavia@thorlabs.com
mailto:sales@thorlabs.jp
mailto:chinasales@thorlabs.com
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Thorlabs 'End of Life' Policy (WEEE)

As required by the WEEE (Waste Electrical and Electronic Equipment Directive) of the
European Community and the corresponding national laws, Thorlabs offers all end users
in the EC the possibility to return “end of life” units without incurring disposal charges.

This offer is valid for Thorlabs electrical and electronic equipment
   • sold after August 13th 2005
   • marked correspondingly with the crossed out “wheelie bin” logo 
     (see figure below)
   • sold to a company or institute within the EC 
   • currently owned by a company or institute within the EC 
   • still complete, not disassembled and not contaminated.

As the WEEE directive applies to self contained operational electrical and electronic
products, this “end of life” take back service does not refer to other Thorlabs products,
such as:

   • pure OEM products, that means assemblies to be built into a unit by the user 
     (e. g. OEM laser driver cards) 
   • components 
   • mechanics and optics
   • left over parts of units disassembled by the user (PCB’s, housings etc.).

Waste treatment on your own responsibility

If you do not return an “end of life” unit to Thorlabs, you must hand it to a company
specialized in waste recovery. Do not dispose of the unit in a litter bin or at a public waste
disposal site.

WEEE Number (Germany) : DE97581288

Ecological background

It is well known that waste treatment pollutes the environment by releasing toxic products
during decomposition. The aim of the European RoHS Directive is to reduce the content
of toxic substances in electronic products in the future.
The intent of the WEEE Directive is to enforce the recycling of WEEE. A controlled
recycling of end-of-life products will thereby avoid negative impacts on the environment.

Crossed out "Wheelie Bin" symbol



© 2012 Thorlabs80

SPLICCO

Thorlabs warrants material and production of the SPLICCO for a period of 24 months starting
with the date of shipment. During this warranty period Thorlabs will see to defaults by repair or
by exchange if these are entitled to warranty. 
For warranty repairs or service the unit must be sent back to Thorlabs. The customer will carry
the shipping costs to Thorlabs, in case of warranty repairs Thorlabs will carry the shipping costs
back to the customer.
If no warranty repair is applicable the customer also has to carry the costs for back shipment.
In case of shipment from outside EU duties, taxes etc. which should arise have to be carried by
the customer.

Thorlabs warrants the hard- and software determined by Thorlabs for this unit to operate
fault-free provided that they are handled according to our requirements. However, Thorlabs
does not warrant a fault free and uninterrupted operation of the unit, of the software or firmware
for special applications nor this instruction manual to be error free. Thorlabs is not liable for
consequential damages.

Warranty

Restiction of Warranty

The warranty mentioned before does not cover errors and defects being the result of improper
treatment, software or interface not supplied by us, modification, misuse or operation outside
the defined ambient stated by us or unauthorized maintenance.

Further claims will not be consented to and will not be acknowledged. Thorlabs does explicitly
not warrant the usability or the economical use for certain cases of application. 

Thorlabs reserves the right to change this instruction manual or the technical data of the
described unit at any time.
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Thorlabs GmbH has taken every possible care in preparing this Operation Manual. We however
assume no liability for the content, completeness or quality of the information contained therein.
The content of this manual is regularly updated and adapted to reflect the current status of the
software. We furthermore do not guarantee that this product will function without errors, even if
the stated specifications are adhered to.
Under no circumstances can we guarantee that a particular objective can be achieved with the
purchase of this product.
Insofar as permitted under statutory regulations, we assume no liability for direct damage,
indirect damage or damages suffered by third parties resulting from the purchase of this
product. In no event shall any liability exceed the purchase price of the product.
Please note that the content of this User Manual is neither part of any previous or existing
agreement, promise, representation or legal relationship, nor an alteration or amendment
thereof. All obligations of Thorlabs GmbH result from the respective contract of sale, which also
includes the complete and exclusively applicable warranty regulations. These contractual
warranty regulations are neither extended nor limited by the information contained in this User
Manual. Should you require further information on this product, or encounter specific problems
that are not discussed in sufficient detail in the User Manual, please contact your local Thorlabs
dealer or system installer.
All rights reserved. This manual may not be reproduced, transmitted or translated to another
language, either as a whole or in parts, without the prior written permission of Thorlabs GmbH.

Status: 2012

Copyright © Thorlabs GmbH. All rights reserved.
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